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Activity 
Student Handout (Version 2) 

Evolution in Action: Data Analysis 

INTRODUCTION 

How and why do species change over time? In this activity, you’ll explore real data that scientists collected to 
investigate this question. These data were taken from a population of birds called finches, before and after a 
drought in the Galápagos Islands. 

In Part 1, you’ll read about the finches and the scientists who studied them: Peter and Rosemary Grant. In Part 
2, you’ll analyze some of the Grants’ data by calculating key statistics. In Parts 3 and 4, you’ll use this data to 
construct graphs and perform statistical analyses (in particular, a t test) to make conclusions about natural 
selection. The concepts you’ll learn apply not only to finches in the Galápagos but also to any organism in any 
environment. 

MATERIALS 

• access to Data Explorer or a spreadsheet program  
• the finch data set (in Data Explorer or as a spreadsheet) 
• (optional) calculator and graphing materials (colored pencils, rulers, graph paper, etc.) 

PART 1: Learning about the Study 

In 1973, Princeton University evolutionary biologists Peter and Rosemary Grant began studying the finches of 
the Galápagos archipelago, a group of islands about 600 miles off the coast of Ecuador. They collected 
thousands of measurements every year to track changes in the physical characteristics of finch populations over 
time. One of their major goals was to collect enough data to identify associations between environmental and 
evolutionary changes in finch populations. 

For their study, the Grants focused on the medium ground finch (Geospiza fortis), a seed-eating species of finch 
on the island of Daphne Major. Every year, the Grants measured physical characteristics like wing length, body 
mass, tarsus length (the section of leg between the ankle and knee), and beak depth (a measure of beak size) 
for hundreds of individual medium ground finches (Figure 1). Small differences in these characteristics can be 
important for survival in different environments. In addition, these characteristics tend to vary widely within 
finch populations.  

 
Figure 1. Diagram showing four physical characteristics that were measured in the finches. 
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In early 1977, a drought began on Daphne Major. This drought caused the type and abundance of food available 
to the finches to change rapidly. Medium ground finches prefer to eat the small, soft seeds of a bushy plant 
called chamaesyce (Chamaesyce amplexicaulis). But during the drought, chamaesyce seeds became very scarce. 
One of the only remaining food sources for the finches was the seeds of a plant called caltrop (Tribulus 
cistoides). Caltrop seeds are much larger and harder than chamaesyce seeds and are covered with pointy spines.  

The drought lasted for 18 months and killed over 80% of the 1,200 medium ground finches on the island. The 
Grants were interested in determining whether there were any differences between the finches that survived 
the drought (survivors) and the finches that did not (nonsurvivors) — in particular, whether any physical 
characteristics were key to survival. To answer this question, the Grants compared the average values of 
different characteristics in the survivors to the average values of the same characteristics in the nonsurvivors. 
They then used statistical methods to determine whether the differences they found between the two groups 
were likely to have affected survival or just occurred by chance. 

1. Describe the major environmental change on Daphne Major that took place in 1977. 

2. Based on what you know so far, what differences (if any) do you think there were between the finches that 
survived this major environmental change and the finches that did not? 

To see whether the differences you expected are supported by the data, you will explore one of the Grants’ data 
sets. Open the finch data set. In Data Explorer, you can do this by clicking “Choose data to explore” on the 
landing page, selecting the “Finches in the Galápagos” data set, and then clicking the “Data” tab at the top.  

This data set contains measurements of physical characteristics (body mass, wing length, tarsus length, and beak 
depth) from 100 medium ground finches on Daphne Major, all born between 1973 and 1976. The 50 finches 
labeled as nonsurvivors did not survive the drought and died in 1977. The 50 finches labeled as survivors 
survived the drought and were still alive in 1978. 

PART 2: Calculating Descriptive Statistics 

You will now calculate descriptive statistics for physical characteristics in this sample of finches. Descriptive 
statistics are numbers that summarize the features of the data and their distribution. Table 1 lists five types of 
descriptive statistics: mean, variance, standard deviation, standard error of the mean, and 95% confidence 
interval. As you’ll see by doing the calculations below, these statistics are related to each other and can reveal 
information not only about the sample, but also the entire population from which the sample was taken.  

Follow the steps below the table to complete the calculations. You can do the calculations by hand, in Data 
Explorer (under the “Analyze” tab at the top), or with another program. Make sure to record each calculation in 
Table 1. The variance calculations are filled in for you as an example. 
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Table 1. Descriptive statistics for four physical characteristics in a sample of 100 medium ground finches: 50 survivors and 
50 nonsurvivors. 

Descriptive statistics 

Nonsurvivors Survivors 

Body 
mass (g) 

Wing 
length 
(mm) 

Tarsus 
length 
(mm) 

Beak 
depth 
(mm) 

Body 
mass (g) 

Wing 
length 
(mm) 

Tarsus 
length 
(mm) 

Beak 
depth 
(mm) 

Mean         
Variance (s2) 1.842 5.181 0.701 0.775 3.087 5.448 0.735 0.709 
Standard deviation (s)         
Standard error of the 
mean (SEM) 

        

95% confidence 
interval (CI) 

        

The first descriptive statistic for you to calculate is the mean, or average, of the sample. 

3. Calculate the mean for each column in Table 1, and record your results (rounded to two decimal places) in 
the table. 

The next descriptive statistic to calculate is the sample standard deviation (s), which measures the mean 
difference between each individual measurement and the mean of the sample. Standard deviation is a way to 
quantify how spread out a set of measurements is compared to the mean. 

The sample standard deviation is the square root of the sample variance (s2). You can use the variances shown in 
Table 2 to calculate the standard deviations. 

4. Calculate the standard deviation for each column in Table 1, and record your results (rounded to two 
decimal places) in the table. 

The next descriptive statistic to calculate is the standard error of the mean (SEM). The SEM is the standard 
deviation of the means of multiple random samples taken from the same population. About 68% of the sample 
means are within one SEM of the population mean.  

As a result, the SEM can be used to measure how well the mean of any random sample estimates the mean of 
the entire population. You can use the formula below to estimate the SEM: 

SEM = 𝑠𝑠
√𝑛𝑛

 

5. Calculate the standard error of the mean for each column in Table 1, and record your results (rounded to 
two decimal places) in the table. 

The last descriptive statistic to calculate is the 95% confidence interval (CI). The 95% CI provides a range around 
the sample mean within which the mean of the entire population is likely to be found. (Specifically, there is a 
95% chance that the 95% CI contains the mean of the entire population.) You can approximate the 95% CI as 
twice the SEM. 

6. Calculate the 95% CI for each column in Table 1, and record your results (rounded to two decimal places) in 
the table. 

PART 3: Graphing the Data 

Let’s compare the means you calculated for the two groups using graphs. A bar graph is often a good choice for 
comparing a single numerical value among different groups.  
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Look at the following example of a well-constructed bar graph. Note that it contains a title, labels for the axes 
(including units), and an explanation for what the error bars represent. 

Mean dorsal fin height among male and female orcas 

7. Construct four bar graphs that compare the means of each physical characteristic (body mass, wing length, 
tarsus length, and beak depth) for survivors and nonsurvivors.  
• You can draw the graphs by hand on a separate sheet of graph paper, or you can make them on a 

computer using Data Explorer (under the “Visualize” tab at the top) or another program. Make sure to 
include all your graphs when submitting this handout.  

• For each graph, make sure to include a title, labels for the axes (including units), and error bars that 
represent 95% CIs. 

8. In some cases, whether or not your error bars overlap can suggest whether the difference between the 
means is statistically significant — that is, due to actual differences between nonsurvivors and survivors 
instead of just happening by chance.   
a. You created error bars that represent 95% CIs. What does it suggest if these error bars do not overlap? 

What does it suggest if these error bars do overlap?  

b. For which of the four physical characteristics did your error bars not overlap?  

9. Summarize the differences between nonsurvivors and survivors that you observed from your graphs. Make 
sure to consider each of the four physical characteristics and the error bars from the previous question. 

PART 4: Calculating t Test Statistics 

To confirm whether the differences you found in Part 3 are statistically significant, you will now do a statistical 
test. The appropriate statistical test for comparing two sample means is the Student’s t test, also known as just 
the t test, which assesses whether the difference between the means of two samples (in this case, the 50-bird 
nonsurvivor and survivor samples) happened simply by chance and is not statistically significant. This would 
indicate that the means of the populations that the samples came from (in this case, the overall nonsurvivor and 
survivor groups) are the same.  
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Mean dorsal fin height in meters 
(m) for 36 female and 36 male 
orcas (Orcinus orca). In this case, 
error bars represent 95% CIs.  
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This hypothesis — that the mean of the population from which the first sample came is equal to the mean of 
population from which the second sample came (so any differences in the sample means just happened by 
chance) — is called the null hypothesis. In this case, the null hypothesis will be that, for a given trait, the mean 
of the nonsurvivors equals the mean of the survivors. 

First, you will calculate what is called the observed t statistic (tobs). Then, you will compare the absolute value of 
tobs to the critical t statistic (tcrit), a cutoff value that determines whether you can reject the null hypothesis.  
• If |tobs| < tcrit, you cannot reject the null hypothesis. In other words, the means of survivors and nonsurvivors 

are not significantly different. 
• If |tobs| > tcrit, you can reject the null hypothesis. In other words, the means of survivors and nonsurvivors 

are significantly different. 

The value of tcrit is based on sample size. It represents the t statistic that could occur 5% of the time in that 
sample size if the null hypothesis were true. For example, each of your nonsurvivor and survivor samples had 50 
birds. The tcrit for a sample size of 50 is 1.98. This means that, if the null hypothesis is true, we’d expect a |tobs| 
of 1.98 or greater to happen only 5% of the time. 

10. Calculate tobs to compare the means of each physical characteristic between survivors and nonsurvivors. You 
can calculate tobs using Data Explorer (under the “Analyze” tab at the top), a spreadsheet program, a 
graphing calculator, or an online t test calculator. 

a. Record your results for |tobs| (the absolute value of tobs) in the following table. 
Characteristic |tobs| 
Body mass  
Wing length  
Tarsus length  
Beak depth  

b. For each characteristic, how does |tobs| compare to the tcrit of 1.98? 

c. For each characteristic, make a claim about whether the means of the survivors and nonsurvivors are 
significantly different. Support your claim with evidence from the t test. 

11. Answer the following questions about the finches based on your analysis of the data. 
a. Which of the four physical characteristics do you think were important for the finches’ survival during 

the drought? Explain your reasoning.  

b. Based only on these data, can you determine which characteristic was the most important for survival 
during the drought? If yes, explain how you know. If no, describe what other information you might 
need. 

c. Suggest a biological reason for the differences you found between the nonsurvivors and survivors. 

https://www.biointeractive.org/classroom-resources/data-explorer
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EXTENSION: Evaluating Associations Between Variables 

In the previous parts of this activity, you explored several physical characteristics of the finches. Some of these 
characteristics might be associated, or related to each other. For example, finches with bigger bodies might also 
generally have bigger beaks.  

Let’s explore the potential association between two of the characteristics: beak depth and wing length. One way 
to examine the association between two variables is by using a graph such as a scatterplot. A scatterplot uses 
dots to represent pairs of values for the variables. 

1. Construct a scatterplot showing the beak depths and wing lengths of the survivors in the finch data set. 
• You can make the graph on a computer using Data Explorer or another program. Make sure to include 

all your graphs when submitting this handout.  
• Make sure to include a title and labels for the axes (including units). 

2. Add a linear regression line, also known as a “trendline,” to your graph in the program you are using. (In 
Data Explorer, you can do this by creating a scatterplot in the “Visualize” tab, then toggling on the linear 
regression line in the “Edit plots” window.) 

In addition to using a graph to visualize associations, you can also calculate the coefficient of determination (r2). 
This value represents the proportion of the variation in the y variable that is “explained” by the variation in the x 
variable. For example, if r2 is 0.90, the x variable “explains” 90% of the variation in the y variable. Values of r2 

vary from 0 to 1, with larger values indicating a stronger association between the variables. 

3. Calculate the coefficient of determination (r2) for beak depth and wing length in the program you are using. 
In Data Explorer, you can do this by selecting “Linear regression” under the “Analysis” tab. Record your 
result below. 

4. Based on your results, is there an association between beak depth and wing length in this group of finches? 
Why or why not? 

5. Suggest a biological reason for the presence or absence of an association between beak depth and wing 
length in this group of finches. 

6. Imagine that the abundance of small, soft seeds resumed after the drought ended in 1978. Predict what 
would happen to body mass in this finch population over later generations. Explain your answer. (Hint: 
Think about whether and how body mass could be associated with beak depth and wing length. You can 
make another graph or do additional calculations to check your expectations.) 

https://www.biointeractive.org/classroom-resources/data-explorer
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